
نرم افزارهای اداری تکمیلی
پایۀ دهم و یازدهم

دورۀ دوم متوسطه
شاخه: کاردانش
زمینه:   صنعت

گروه های تحصیلی برق و رایانه ـ هنرـ بازرگانی و امور اداری
رشته های مهارتی:طبق جدول صفحه 5 

نام استاندارد مهارتی مبنا: کاربر نرم افزار اداری و رایانه کار پیشرفته
کد استاندارد متولی: 42/24/1/4 ـ 3 و 87 ـ15/1/2 ف. هـ

هنر… ـ  رایانه  و  برق  تحصیلی  گروه  صنعت،  زمینهٔ  کاردانش،  شاخهٔ  تکمیلی،  اداری  نرم افزارهای 
]کتاب های درسی[ 310184و 311184. برنامه ریزی محتوا و نظارت بر تألیف: دفتر تألیف کتاب های 

درسی فنی و حرفه ای و کاردانش؛ مؤلف: آسیه قره داغی قهرمانلو.
تهران: شرکت چاپ و نشر کتاب های درسی ایران.

]320[ ص: مصور )رنگی(؛ 16/3*23 س م.
3ــ2182ــ05 ــ964ــ 978

فیپا
نام رشته های مهارتی طبق جدول صفحه 5. چاپ قبلی: دیباگران تهران.

کتاب نامه: ص. ]320[. 
١ــ کامپیوترها، راهنمای آموزشی 2ــ نرم افزار، راهنمای آموزشی.

تألیف  برنامه ریزی آموزشی ج   ــ دفتر  الف ــ قره داغی قهرمانلو، آسیه، 1360. ب ــ سازمان پژوهش و 
کتاب های درسی فنی و حرفه ای و کاردانش.د ــ ادارهٔ کل نظارت بر نشر و توزیع مواد آموزشی
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عنوان و نام پدیدآور

مشخصات نشر
مشخصات ظاهری

شابک
وضعیت فهرست نویسی

یادداشت
یادداشت
موضوع

شناسه افزوده

رده بندی دیویی
رده بندی کنگره

شماره کتاب شناسی ملی



وزارت آموزش و پرورش
سازمان پژوهش و برنامه ریزی آموزشی

کلیه حقوق مادی و معنوی این کتاب متعلق به سازمان پژوهش و برنامه ریزی آموزشی وزارت آموزش و 
پرورش است و هرگونه استفاده از کتاب و اجزای آن به صورت چاپی و الکترونیکی و ارائه در پایگاه های 
مجازی، نمایش، اقتباس، تلخیص، تبدیل، ترجمه، عکس برداری، نقاشی، تهیه فیلم و تکثیر به هر شکل 
و نوع بدون کسب مجوز از این سازمان ممنوع است و متخلفان تحت پیگرد قانونی قرار می گیرند.

                                 نام کتاب:               نرم افزار های اداری تکمیلی ـ 3١0١84 و 3١١١84
سازمان پژوهش و برنامه ریزی آموزشی                                    پدیدآورنده:   

دفتر تألیف کتاب های درسی فنی و حرفه ای وکاردانش    مدیریت برنامه ریزی درسی و تألیف:    
آسیه قره داغی قهرمانلو )مؤلف( ـ هما تیموری)ویراستار ادبی( شناسه افزوده برنامه ریزی وتألیف: 

ادارۀ کلّ نظارت بر نشر و توزیع مواد آموزشی              مدیریت آماده سازی هنری:   
تهمینه کاشانیان )صفحه آرا( ـ بیتا اشرفی مقدم ) طراح جلد(             شناسه افزوده آماده سازی: 

تهران: خیابان ایرانشهر شمالی ـ ساختمان شمارهٔ 4 آموزش و پرورش )شهیدموسوی(                               نشانی سازمان:  
 ـ8883١١6١    ، دورنـگار  : 88309266 ،  کـد پستی   : ١584747359  تلفن  : 9   

www.irtextbook.ir و www.chap.sch.ir :وب گـاه  
 ـکیلومتر ١7 جادهٔ مخصوص کرج   ـ خیابان6١ )دارو پخش( شرکت چاپ   و   نشرکتاب های  درسی ایران : تهران                                              ناشر :   

 ـ44985١6١،    دورنگار: 44985١60، صندوق پستی: ١39ـ 375١5 تلفن :5   
                                         چاپخانه:   شرکت چاپ و نشر کتاب های درسی ایران »سهامی خاص«

چاپ اول ١397              سال انتشار و نوبت چاپ:   

ISBN   978 - 964 - 05 - 2182-3           978 - 964 - 05 - 2182 -3 شابک
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همکاران محترم و دانش آموزان عزیز:
پیشنهـادات و نظرات خـود را در بـارۀ محتواى این کتاب بـه نشانى 
 ـ   صندوق پستى شمارۀ    4874/15  دفتر تألیف کتاب های درسی فنى و  تهران 

حرفه اى و کاردانش، ارسال فرمایند.
tvoccd@roshd.ir پیام نگار)ایمیل( 
www.tvoccd.medu.ir وب گاه )وب سایت( 

محتوای این کتاب در کمیسیون تخصصی رشتهٔ کامپیوتر دفتر تألیف کتاب های درسی فنی و 
حرفه ای و کاردانش  با عضویت: بتول عطاران، محمدرضا شکرریز، سیما سجادی، شهناز 

امین، اکرم راعی و سید رسول حسینی تأیید شده است.



پایهرشته مهارتی ردیف

10برنامه نویسی پایگاه داده 1

10بورس و اوراق بهادار 2

10برنامه نویسی بازی های رایانه3

10عیب یابی و مونتاژ سیستم های رایانه ای 4

11تصویر سازی و جلوه های ویژه رایانه ای5

11تولید محتوای الکترونیکی6

11طراحی و توسعه صفحات وب7

11امور اداری8
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پیشنهـادات و نظرات خـود را در بـارۀ محتواى این کتاب بـه نشانى 
 ـ   صندوق پستى شمارۀ    4874/15  دفتر تألیف کتاب های درسی فنى و  تهران 

حرفه اى و کاردانش، ارسال فرمایند.
tvoccd@roshd.ir پیام نگار)ایمیل( 
www.tvoccd.medu.ir وب گاه )وب سایت( 

محتوای این کتاب در کمیسیون تخصصی رشتهٔ کامپیوتر دفتر تألیف کتاب های درسی فنی و 
حرفه ای و کاردانش  با عضویت: بتول عطاران، محمدرضا شکرریز، سیما سجادی، شهناز 

امین، اکرم راعی و سید رسول حسینی تأیید شده است.
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Find & Replace����	%���K�T'�������E%h
D�	%�h������ ��� � ��� ��� ����Ctrl+F�4��C'#����� �� �� ��	%����� ���� �$���
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���K�T'������U�

�����Change������c���-%��������������}%B`D���������Ignore Once�
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k���������	HD����!	�	P�������f
����������!��	�%���K��T'���!�

���������.w#Insert�����*�Cells���4����B��������D�	%���K�T'������Insert Cells�������������$���K��T'������

�����*Shift cells rightO��#�������)e'���"#���"�#����4	��K�T'�����������������*�K��T'���������	����

Shift cells downO��#�����O�e'����%��5�"�#����4	��K�T'�������O��#���	���������)�B�����	��	P�����

������I����E1��	��$������*Entire row���Entire column#����
A#���	HD����U�'�����!4	���K��T'�������

������I��U�'#����
A#��	���<�)+��=>=?$��

��
�123A)�*)�9���5��'�@�Insert Cells 

O��#��	'���!O��#�q_
���
��4�
��K�T'������
k���������!���������.w#�Edit�����*�Delete Cells����

D�	%�����K�T'���4���B�������� Cells�Delete����
��9��$���rTX����������������q_�
����.5�������

O��#����O��#�!4	��K�T'������������������	�����)�e'���i�]�"��#�����4	���q_�
�"�(�1�"�#���"��#����� �

(Shift cells left)����O��#��	�����O�e'���/��������%��5����(Shift cells up)�$���������*�K��T'��������%�J��

Delete entire row(s)���Delete entire column(s)U�'#������
A#��O��#�������������4	��K�T'������

U �	�������
1���!���q_
��	��� <�)+��R>=?$��

����4�
���K�T'���U�'#����
A#�!
k���������	HD�����	'���	%������I��U�'#����
A#�	�]����-��	%���T��
*�

���������.w#Insert�����*�Rows<����
����I��
A#�U�
�? ��������*����Columns<�������I����
�����U�
��

U�'#�?	%���*
����$��
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<,��-�������=�����8��+�������������������������� �

'������	��8���(�����7����1��-��������������������������������������������������������������'������	��8���(�(��>$?���7������� �

9���3(�@ABAC@A@C9D�����������������������������������������������������������������������������9���3(�CABABE9�F�9G���������������������������������������� �

� �

��
�123A+�*)�9���5���'�@�Delete Cells 

�'�(�@�
�

U�'#���
A#�U�
��q_
������I���

	
 ���O�s�������������������������4�
��K�T'��������#�
A#�Insert�������*�Rows��������-�����D�	%���K�T'������

����I��)B���������	�	P�
A#����<��)+��>=?$ 

����������������������������
�123A,�*)�$	�Y ��'�@�!��^����

�
 O��#�����B1,B2,B3,B4,B5,B6���������������4�
���K��T'������Edit�������*� Delete Cells���

�4�����B���������!	��%���K���T'���Delete Cells��������*Shift cells left�	��%���K���T'������� �

<�)+��p>=?$ 

�������������������
�123A-�*)M0�	��=>�_`����

4��G��<�e�����������8RE����
�d	���

��������!	�	P�f
�����-��U�
�����I����
�� Insert�����*�Sheet���4����B�������������	%���K�T'������

Insert Sheet���������D��6����������������������������P�f
���������)�E1�	��	P�f
������	�%���7!������*�� �

Before current sheet'���������
*����	%���K�T��	%���7�	�	P�f
���h�!��
*�u������P�f
��������	H�
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����*�After current sheet	%���*
������$����%
�����Sheet��4����B���������Insert Sheet������'�����������

Name!�������������������	��%���i����D����	���	P�f
���������
����
��k���������������OK��	��%�����-��%���� �

<�)+��R>=?$��

��
�123A?�*)�9���5���'�@�Insert Sheet 

�!�"&������*�����No. of sheets���From file���4����B�����������Insert Sheet�����
��������]�

z	������

<=�G��07����#�	���F�.��"��

�3D
����
�4�������#�������������Data�������*�Sort��	�%���K��T'�������$���4����B����������Sort������������ �

Sort Criteria%
��������Sort by3D
�����	%���rTX�������������	�����U�'�#���	��
���e��0�#��
�����#

�������*�����+��K�T'��������Ascending
*�����Descending

+������3�D
��U�����,����������H6�������%�%HD��������#

	%����$���

                                                          �
=>���H6���

�>�,������
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'������	��8���(�����7����1��-��������������������������������������������������������������'������	��8���(�(��>$?���7������� �

9���3(�@ABAC@A@C9D�����������������������������������������������������������������������������9���3(�CABABE9�F�9G���������������������������������������� �

� �

4����U�'#�-���������D��6����	%�����'����
��
�����!��%
������"#��
'2��Then by�����
�N���U�'#��

�	%���K�T'���!"��,����%%HD���
�<�)+���>=?$��

��
�123AA�*)�9���5���'�@�Sort 

<<�G���	� @����(�	���

�����4��������+%��
*�;�����-��!������������������(���e����b���FG��)�%�BD�������D����"#�������������������� �����

4�����%����ED������U�# �������
D�	���$�����
�OpenOffice.org Calc�'��b���+��������������&�#����
�����

�����
1�
�������%'7�����	���$��

�����4����0�#��
���������u�����
����O��#��	'���!�������������4�������������U ����������������������4�
���K��T'���!	��������
1

������Insert�������*�Chart���	%���K�T'�������$����4����0�#��
���������-���������������f
���������������$�������

�4���B�Chart Wizard���
��9�����4���B��������������4��C'#�����������������%�%HD������������M����	%���D

	%�����$4����M���0�#��
���������M����/��H��� �� �� � ��� �� ��� ����� � � ��� � ��t� � � � ������%%HD�
k���������� ���%'���������� <�)+���>=?$��

�����%
������4����B�������i]�"�#���������!�������M���K�T'������.5Steps�������*�����Data Range�

�"�#�����D�	%���-%��"#�������!4������	B���HD������%	%������%�$������������*�K��T'��Data series in 

rows4�
*����������*�K��T'����������
A#�0�#�
��4�������Data series in columns�4�
�*�����
���4��������

U�'#�0�#�����rTX������	���<�)+���>=$?��
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123�AB�*)�!= D��Chart Type�'��9���5���'�@Wizard �Chart 

��
�123AC�*)�!= D��Data Range�'��9���5���'�@Wizard �Chart 

�����*�K�T'�����#���

�Data Series��%
������Steps"#���$�������������4��C'�#��������

��������Add�

�������	%����������	�	P��
#�	%���D���������������D��6�T�����	�%���q_�
�����
(�+��	%��!����U ���"(�%,���

�
#���������4�
��K�T'�����Remove����	%�h�x%�h�<�)+���>=?$��
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��
123�AE�*)�!= D��Data Series�'�9���5���'�@Wizard �Chart 

����2]���

����(Chart Elements)����U�����	%���D����B��!���������
������X���B������Y��%%HD���

	%�� <�)+���>=?$��

��
123�BF�*)�!= D��Chart Elements�'�9���5���'�@Wizard �Chart 

����������

��
����x%�h��������Next��������������������	�H��b���%k�D���������%�������D���6�������'����	H����

�����

	%�����'��	�!���������	%���DFinish���������������D�	%���K�T'���������$��

�'�(�A�
�

�������&#���

	
 ���O�s��������O��#�!A1������������N���%��5������K�T'�����������	�%����'���Shift�����O���#�����!D6���-�%���

	%��$ 
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�
 ����������Insert�������*�Chart��������4����0�#��
�����������D�	%���K�T'�����������������4	��K�T'������

���<��)+��=>=$? 

��
123�B)�*)�� 

��
 ���4����B����������Chart Wizard���!��"�(�1�Data Range�������*�Data series in rows����

��������	%���K�T'��Next	%���-%������$ 



 ���

���Data Series4�����
#�"(%,����!��!��Ahmad��������K�T'������Remove�����x%�h

	%�h$ 

)
 ���������Finish	%�����4	��X��	�	P�b��%k�D���������������D�	%���-%����<�)+��R>=?$ 
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��
123�B+�*)�� 

<��G�������[��
������#��HI�OpenOffice.org Calc 

������U�
���4
�%7ZOpenOffice.org Calc��4
�%7Z��%E�����������
���������#�OpenOffice.org Writer���

OpenOffice.org Impress"#���$�����������4�
'(*��BC6�-��U�
��4
%7Z���
�File�������*�Save����

�4���B�������D�	%���K�T'��Save As��������!4
%7Z�)B��.w#�����������K�T'������4�
'(*��BC6�U�
�


��
k������	%���i��D����)�������$�����
�Calc)������	��(5�������4�
'(*��BC6����.ods���4
%7Z��	���$

������������"(�%,����	�%���4
%7Z��
N���	��(5�������)����	%���T������D��6���File Type�����U �M����

������������4�
��K�T'��Save	%���-%����$��

���4�
'(*��BC6����"9�C
���
�������	%���D����Save with password����E���������4�����-%���

�����
��%HD�)%�	%������<�)+���>=?$��
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��
123�B,�*)�9���5��'�@�Save AS��

��

������������	
����

The menus are context sensitive. This means that those menu items are 
available that are relevant to the work currently being carried out. If the 
cursor is located in a text, then all of those menu items are available that are 
needed to edit the text. If you have selected graphics in a document, then you 
will see all of the menu items that can be used to edit graphics. 

File 

These commands apply to the current document, open a new document����or 
close the application�� 
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Edit 

This menu contains commands for editing the contents of the��current 
document�� 

View 

This menu contains commands for controlling the on-screen display��of the 
document�� 

Insert 

The Insert menu contains commands for inserting new elements in��your 
document. This includes sections, footnotes, notes, special��characters, 
graphics, and objects from other applications�� 

Format 

Contains commands for formatting the layout and the contents of��your 
document�� 

Tools 

Contains spelling tools, a gallery of object art that you can add��to your 
document, as well as tools for configuring menus, and setting��program 
preferences�� 

Table 

Shows commands to insert, edit, and delete a table inside a text�document� 

Window 

Contains commands for manipulating and displaying document�windows� 

Help 

The Help menu allows you to start and control the OpenOffice.org�Help 
system� 
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$%
&'��	��

��

Adjacent ��������

Alignment �	����
D��

Allow U����4��P���

Animation �
B'��4��P�!�X%�%����

Apply ���U�
�������

Ascending ���H6 

Background .5���%����

Border ������

Cell ���7�!O��# 

Chart ��������

Column U�'# 

Contain )����U	���

Current ���P 

Data 4��� 

Descending �,��� 

Document 	�#��

Drawing &%#
D 

Effect 4��P��

Element 
`����

Formatting 3,�1�	��� 

Insert u���U�
� 

Layout U��	%]��

Line a7��

Move ��P��U�
��P 

Negative �C����

Next �	H� 



�

�
�
�
�
�

(6����
������7�8��+��2���9���:���2���;�
+�,���1�2
<,��-�������=�����8��+�������������������������� �

'������	��8���(�����7����1��-��������������������������������������������������������������'������	��8���(�(��>$?���7������� �
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� �

Non-adjacent ������
%^��

Object ����

Password 4@���_*��

Protection "k��B���

Remove q_
�U�
���

Row 
A#��

Select ��K�T'�U�
���

Sensitive �0�(
��

Shadow ���#��

Shape )+� 

Sheet f
���� 

Shrink 4�
X�����#��

Sort 3D
�����# 

Spacing ��6������_*��

Step ��

� 

Title U������

Tool�� �������

Transition ��_*��
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()�*��'!+� 

��

• �
���������OpenOffice.org�����������9��-��
�����"#����
���������
��;��)������������������6�7�8

���	����$��

o �������OpenOffice.org Writer ��4@�������
������
5��

o �������OpenOffice.org Impress��3�A������������
���

o �������OpenOffice.org Calc��4�
'(*��BC6���������
���D�E#�B������
���

o �������OpenOffice.org Base��D��FG��-��������
����

o �������OpenOffice.org Draw��&%#
D�����
���

o �������OpenOffice.org Math���,��H��;��
�������
���I����4	%J%5������

• �����
�OpenOffice.org Writer����M������
���#���K��'��!L���*�!"��������'��������������
��

�����������'��
����'E�����	�#���������������D����N��
��!����������������O��H����G������������!����

�����
1�4��C'#��������
%*$��

• �����
�OpenOffice.org Impress��������
���%E���3�A������������
��-��PowerPoint��"7��#�

���������������!�'�������
����	�F#��"7�#���;�����������U�+������"#��"��#�
+����"�
�

���&��
�����O�	P�	���$��

• �����
�OpenOffice.org Calc���#�B����
����������
��-����������
���%E����D�EExcel��"7��#�

�����������������	������!��I����b��%����
����'E�����������
P��U�+�������������"#��"��#�
+����"�
�

�P�������������� ����#	�2��b�E#�B��!�	���	��$��
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 �������Openoffice.org BaseB-��-�$-���� ��4���

CD�
��4@������
5� �E
 �3�A�������� �F
��D��FG��-������ � � ��� ������� �-
4�
'(*��BC6��������� � �� � �� � � � �� �� �����

+
 7D�G�$�������%��$�<� ���%�������-OpenOffice.org Writer�����H-�0�%9��$���%������%���%4�8��

3��B-�2��

� �CD�
�Formatting� �E
�Drawing Tools� �F
�Standard� �-�
�Writing Tools��

,�
 ������������H���/���-� ��-���I���J�� �K��=���#��-�L�M���?1�N�O�P<&�$���Paragraph�������H-����� 

3��B-�2��

�CD�
�Indent�� �E
�Line Spacing�� �F
�Spacing� �-�
�Register-True 

Q
 ��-�������2�I�R���������&��STOpenOffice.org Writer3��H-�0�9���<��J�� �8���B-�2��

� �CD�
�Format�Page�� E
� Format�Style and Formatting 

� �F
�Format �Paragraph� �-�
�Format�Character 

U
 ���!�=�J��% �E�%5�����%����H�%V<#��-��%<Presentation Wizard��%�������-�OpenOffice.org 

Impress3��W�B-� �-�V!��3D����!�"��X!�R��&��

� �CD�
�From Template� �E
�Open existing presentation 

 F
�Empty presentation� �-�
�From File 

:�
 ��ST��<!�=�J�� O�P<&���%�������-����!;%9��3T����OpenOffice.org Impress�%�����% ���

3��B-����

CD�
��Handout� ���E
��Notes Page�� �F
��Outline� �-
��Slide Sorter 

Y
 ��? �J�� �����3Z�[�&���!�"��$�"��(Slide Show)3��'��N��B-�2��
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Use the Unfiled Notes section when in doubt 

When you don't have time to think about where your notes should go, just 
click Window logo key + N which immediately launches OneNote and 
creates a new page in the Unfiled Notes section (click the button at the 
bottom of the Navigation Bar to jump to it later). It's okay if this section gets 
big. You can drag the pages to other sections later, or just use search to 
find them in this section��
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10- When you don't have time, where should your notes go? 

a- All Notebook List 

b- Unfiled Notes Section 

c- Personal Notebook 

d- Work Notebook 
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Open a site from Office SharePoint Designer 2007 

To open a SharePoint site, you must have at least the View permission for 
that site. This permission is included by default in the Full Control, Design, 
Contribute, and Read permission levels. If you don't have the necessary 
permission, contact your server administrator. 

As an alternative to the following procedure, if you have recently opened the 
site, you can point to Recent Sites on the File menu, and then click the site 
that you want to open. 
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1- On the File menu, click Open Site.  

The Open Site dialog box opens. 

 

By default, the Open Site dialog box opens with Web Sites selected on the 
My Places bar and displays all sites that have been opened by using Office 
SharePoint Designer 2007. 

2- In the Open Site dialog box, do one of the following:  

•••• In the large list box, click the site that you want to open, and then 
click Open.  

•••• In the Site name box, type the URL of the site that you want to open, 
and then click Open.  

For example, you might type http://My_server/My_site. 

�
���� No folder or site names appear in the Site name box until you either 

start typing or click the arrow.�

3- If there is currently another site or file open, the site opens in a new 
window. 
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Change 9&	&�
��{4��

Client �
/)���

Content 	�/����

Default V�*�q
0��

Empty nH����

Folder �(�* 

Gallery �
H�1��

Homepage n5�	�������

Hyperlink ./�
�	��

Image 
%�74��

Movie +5�0��

Organization 9�� ����

Photo E@���

Preview V�*�V%�'���

Properties �����7���

Server E%�
��8�"�&��

Sound 	����

Split 8�""�	�M 

Style $?���

Template �RH	��

Untitled 9	�"��9�����
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10- To create a new website you: (Select all that apply.) 

� ��a- File�New�Page      b- File�New�Website� ����� 
�   c- File�Website�New d- File�Page�New      �  
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Tables 

Tables are the core database objects. Their purpose is to store information. 
The purpose of every other database object is to interact in some manner 
with one or more tables. An Access database can contain thousands of tables, 
and the number of records each table can contain is limited more by the 
space available on your hard disk than by anything else. 

Reports 

You can display the information recorded in your tables in nicely formatted, 
easily accessible reports, either on your computer screen or on paper. A 
report can include items of information selected from multiple tables and 
queries, values calculated from information in the database, and formatting 
elements such as headers, footers, titles, and headings. 
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10- Which object do you use to store information on Access? 
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•••• A table is just one of the types of objects that you can work with in 

Access. Other object types include queries, forms, reports, pages, 

macros, and modules 

•••• Tables are the core database objects. Their purpose is to store 

information in Database. 

•••• You can display the information recorded in your tables in nicely 

formatted, easily accessible reports, either on your computer screen 

or on paper. 

•••• You can use the Report wizard to get a quick start on a report, but 

you will frequently want to modify the resultant report; you can do 

this in Design View 
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� �78"��Database Tools� �9��Home��

� �:�� Design� �,���Create��

	� ��������"#!$�%"�;<=���)>2���?@A"�B�=�)"������'!�$,�%"�&!������'!���%�2,�, !C ��)�!*Create�

(��-,�./0"�+#�D$ 

� �78"�� Report Design�� �9��Label��

� �:�� Report� �,���Blank Report��


�� ��"#$(���"2���%�)�*2�$�%"�&���,2"3�>�2,�6" �Report+,",���5�"� 

� �78"� �"���������#;������ �9�Q/�
���������� �����

� �:��!��;d�3�i
��&&X/���� �,���(�)�*�������#?&5�3��d��5�:���

�� ��������,2"3�>�%"�-,�./0"����12"34�,�5�"�)"��Report����"#!$���5�"�E�������!�F�?�%"�&!��������!�%�)�!*

)2>��"�+G0 

� �78"�� �"���������#;����� �9�������m- �8&&�/���

� �:�� ���������#?&5�c�9���� �,���Q/�
��������� �����

�� �G0"2�)"������H=������=���������������"#$�%"�E�/����/D$����;<=�����/D$�2,�, C ���/��6,�$���=

->�4�%"�&���'���%�)�*Design(��-,�./0"��+, I 

� �78"�� �Controls� �9��Views� �:��Tools ,���Font 


�� ���"�)"����������&���JD��E-" �8,���?@A"�%"�(K���'$��������6L�E#� I�B�=�12"34�)"#/�"�2,�2�������"2��!*

(��2"�M�12"34�%"�(/�<M�'=�2,�+#�*, 

� �78"�� Report Header�� �9��Report Footer��

� �:�� Page Header � �,���Page Footer 

�� �'�$,�%"Group & Sort�'���%�2,�Design(��-,�./0"�)2�$�'=�)"���E�+, I 

� �78"�� ���������#?&5�3��d��5�:�� �9��"����������#;������

� �:�� ������m- ��&&X/ ,����������D���,P$��&&X/��
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0	�������������������������������������������������������&������	��0���'$�0�9�&�
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��

1���2'�:;<;=:;:=6>�����������������������������������������������������������������������������1���2'��	�?�$@A�B)����������������������������������� �

� ���

8- Which object is used to display the information recorded in tables on screen 

or paper? 

a- �query� b- report� c- table d- form 

�� ���-,",�2 ND��'=�'���������4�"2�12"34�2,�, C ��)�*->���(��)#D���O�D$+����"2�2�!$��!�"���!5�"�- ���

#�D$�P��Q�R 

��� (��%���(�����'=�2,�"2�6L�E12"34�S@T"�)"����+#�D$ 

��� ��/D$�%"�(��-,�./0"�)2 ND��'=�'���/��>�;<=���)�*�+, I 

�567�*���4��

��

�� ������
���H/�)�*��0���Northwind���������������"��������� �����"����7��������Report����#$�g"�����H%�����1�!"

Suppliers[�3��#��;;7#&F
/�`�#��&;d�����=���+����#��?&5company�1Last Name�1First Name�"�� �

Job TitleT��������������6���� ��� � ��� ���� �� �&#�
%�#�+ 

	� �������3K�3�
;)�"����7�����H6��*�g�����������������3��#;;7#&F
/��������#&����&&X/+ 


�� ��#��&&X/����������3�
;)�,�
5�q���"���������3K�"�������z "�\E%�#&;d�U&>;/�8&J+ 

�� ����;/�H?E%������������>���������������I��J���-i��g����"�������!"���D���g"��������I�J�b���/��7�#&;d�U&

�
%+ 

�� �#?&5�g�;-
������������Job Title�"���#&;d�g#;�+ 


�� #&;d���&�'���������+ 

�� ��
�������Access#�
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���������������������������������� ���� � �� �� � ��� � ��� ��� ��� � ��� � � ��� �� ������������������� ��� �	������������������� !"��#�������� ���� � �� �� � �� � � ��� ���$��%����&��'�� � ������ � �� � ���

���#(�������� ��� � ���������)����*������+�������������� �� ���� �� � ��� � � � �� � �	����,�-������ �� ���.���/�����0��,����� ����� ��� �� ��� � �����(�1��2���,���3��������� �� � ��� �� �� �� ��	����,�%14���5�1%�����*������ ��� �� �� �� � ��� ��

�6�7� � �������������#�/����8���2���0��9��'�7��&�������� ��� �� �� � � �� � ��� ��� �� � �� ���������� �*���4�:"�������� �� � ��� � �������#�;4���<���������� �� � � ��� � �� ��������$������ � ���������,�1������1���1�=����������� �� � � ��� � ��� ����1�������� ��

�%:'� �� �����7�/������� ��� ������)��"�(��>� � �� � �����	����$��?��� � � ����

@��� � �������A������� ��Visio������A���0�����4���������1
������
�
���(��/���%4��������;4��@�������������,�1
#��B1�������1����	������1���

��<)�(��CD%E#�,�4��F#��D����7�,���E%#�*����G��H�����#(����
�I���������#��&����*�����������/�����/J7�K�*�&����7��1&

;���I���&	�����������7=���>��<�����@�������L������������'�M�#�L)�#�����B����N��4�L��O#�����PQ�7�7�������

B%#�(���&	�R�S��������
�T%���*/������%:'�7�M��

�����"�7�B�'�����������6�7����&	@�������A��Visio#����=�������M��

��������	
������
��	�������������� 

@�11�����A11��Visio���A11���011����114�@����11����������%114���E:11��7������11��;114�U(Standard�11��"�7���	�

(Professional)��@�1���%:1�����;��47�
��#�;����V4�������A1��	�Microsoft Office 2007���1������/�1��

;4��M���@�������7��&����<��W�������&���#���������&����,�����������&(����*������H������!#��E:��7��(��0�	�7��%#���

#� �S���������(�4X��

• Visio Standard�������E:��B��	������	�����1����%���1��;14�����#�������;���I��G��H��������

��@�������7��&����<���&	��H��	����	��-1������1��������,�����&�1��	�1H����	����1���(���/��1��*��*

,�#(�4�&��,�#(�*����	�������H����������#����4�7�/J7�K�M 

• Visio Professional������E:��B���	��1���,�����1��������,����1#�*�
?1��,����1#�*,�1"��S�*IT�*

��������#�����7�;��%����7�57�,�"��S�7�,���E%#��@���,�:������������%-1��������1��Y���,�4��F#�7���A��	�

�����*������%4���E:������#��<&����/7Z3�7�����	�6�7����%-���	�&	�;4��M��

'���;�D����(����&	@�������A��Visio�������%'������#���;4��/�#=�X��

�������	�
�����@���(��/���%4����������A��Visio�#����/����,������������/����(��7�/��'[�@�������L�����������&���\��A���&

������F��M��
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�������������	������@��������A��Visio�#���������������������01��,7���G�13ZS�����/���/��'[�B%#�(��/���%4�����

�&����<�������'���S����/��%:�����]	<����H���CD%E#�����M��

����������������������	����@�����������A��Visio�#��������,���	���������G���]�*�.�����4��������4���0��(��
�T%���

�*�.�����4����57��<��/���%4���&����K�Y���(��M��

���	����� ���!"#$%���&����'��(����'������#����@�������,������������4������4�7��&����<��7��&����������A1���@�1������1&

Visio@����.�����������&��A��	�������	��1�����Word�*Access�*Excel�7�Power Point������1����1��^1T%�#

,=��;#����������&HTML�7�/����/��'[���������!�����;��%	������<�����Q��57�G���]���M��

�����������	�
��
���Visio��

���	��)��	��#�����Visio(�^"��#�*��^
�����_��O#�����`ab���
�?�����X��

)* 7�	��<���StartD������0��M 

+* ��#�(�	A��/���(������� All Programs �<��5�E%��������M 

,�* 7�	A������Microsoft OfficeD������0��M 

-* �#�(��	A��/���(�������Microsoft Office Visio 2007�<��5�E%���������M 

��
�34/�)5�.26����7�� ����8�Visio ��

�������
��
��������Visio 

�(��cK��)�	����]�*�#������	_��O#��^
��dab�#�/����>��<������M��

�
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�34/�)5 ����8�9�6���Visio 

�B����]��3(�������?3����]X��

• &������'
�.
�����Template Categories)/��%:����T?S����1��	���1&�.���(��/�1��	��/��1#=�

������14���W��1���;F)��&�;14�M�1%�7���%14����	��1#�5�1E%�������������;<:1������1&�.���;:1����1���

Template#����e�������M 

• Getting Started���;<:����#�#�^#������/�H�K�������M��%�#�7�L:���	����1��L14��%#�,=�

�.����������^�#	��#����e��*/���5�E%�������M��

• �����
��	0��(Recent Documents)���̂ 1������1&	���1D?��/�1����1H��������Visio��>��1<�����

#��#�����&���,=����,����4�%4���&�7��0�D�����7�;����	�&������(������,=�0�M 

• &��#������(Samples)��������<��;<:��B�������	���&�.���(���4�%4��7�/�&�-#�^��������%:1&��M��1���

�;<:��(�Template Categories����A��*Samples����A�������*���#�>E���������W��1���/�1H�K�

�9��'�����
<��G�3ZS��;�����Visio 

�%4���&�.���	��� 

^����/�&�-#��D?��	�&����'��/���5�E%���	�&�.�� 



�

�������������

�

�0��1�� ����%'������5��67�(	
�
�(�+	
��
�������

�����20�'�������	�#��	
��
Visio 
�

�

 

�&�.��	�������/��#=�Visio������>��<��/������&��'��M���01��&�5�E%�����*��������/�1H�K�;14���;<14����

#��&�f�V?��#�G���Q��������M���]��������A��/�H�K�;4���;<4�������Open Diagram 

��������*�����5�E%���������/�������������<��@����&	��������1��7�������&��'�/�&�-#�V?��#�������1��A��5�1E%��

Open Sample Data/������&	�V��#�������<��@�������Excel#�>��<��������U��^
�gabhM 

��

�34/:)5�2;���View 

��������
���������� 

����.���5�E%���(��cK���� � ���� �� �������� �	����������#���� � ��� �� � �*�������]����� � � � ���4��� �� � ���#��&�f�/�H�K�0�������� �� � �� ��� � ���� ���� ������A)��*����� � ���� � �	���^
1�����/�H�K����� � � ��� ��� � ���i�aj���

;4��/���/����,�-�� � ���� � ��� �� �� �� �X��

• �1!2�&	3�������(Shapes)�������̂ 
��W�����;<:��B���������������/�1��5�E%���	�.���W���k�4���������&

�>E���������%4��CD%E#�	�&��/���	����������#������k�%4�����*�����������M�������%14��B1���(���1'�������1&

�(�������?3BackgroundscK����e��	������*���#(Borders and Titles����"���4���	������7��&

,���3��7��&Basic Flowchart Shapes��	���/��l�7�G����D�����K�
�
��M 
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• ����	����&��4(Drawing)�����!l�������<&�;<:��B���H��O��������	�����������1��;4����4���	�

V'�>��������#�R���7�m��;<4�������&�������M���B��n<&��������]�B���K�7�;4���;<4��*��&�����	�

�����>��<�K�;4���%���M 

• 50�67�����V'��>���&	���<3�	��T���7���������������	�̂ 
���������,=�/(��1���B�1�I��7��&�����01<���1&

#������M 

• �&��4�&��'�������(�����������7�������������4������]��	�&����<����H���	��������1]��	��B1���(��

#�/���%4������(�����M 

���"��

^
���&  

��4������] 

��(���]�����&  

��#���� 

���A������Standard 

���A������ 

Formatting � V'�>���&��
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• ��'�����������R������	���&��A���/�H�K�	��#�����������%4��Visio����	��L1����7��1��e��*��H������1��	�

^
����%:&��&����<��7��&M 

• ���������(Menu Bar)���7�"������B��	�&��#�	�D%E#���1'���������;4���,=�(������^1?��(���1&

��%:&����=�M��&��#�(�����<��������(�����(��������%-���	������*����=�#������X 

Tools�������&��A�����#�B������������	�����
�
��������4���Visio������4������]�*Visio���/���/�&�-#�

��&��A���7�����	V'�*o����������>��0?-#�*�&�#���������%'�����/��l�7��&������M 

Data��������]�������E:��(����Professional����1#�/���%14��������1�#�*�1���	�Data��̂ 1�������/�&�-1#

�����&��'M����A�����Link Data to Shape�4��,�
#��#��������4����G�3ZS��(��/���%�����1�����1&

Access�*Excel�7�SQL Server�/��l�7�p#��&�������M����1��A���1��Display Data On Shapes�

/��������A��7�/���/����>��<��^
��	7���&Reports,�
#��\��A������	#��&������������M� 

Shape���������#�B�����	�,�#������&������	���������/7�1��^1�?��(��/�1����14���
�
1���;����#����1��	�*

�����(����7�,���'��	����.���5�E%������	���o���;4��M����������1#��1�#�B1���(��/���%14�����B��n<&����,��1�
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Create a basic diagram 

1- �Start Microsoft Office Visio.  

When Visio starts, several windows appear. For now, all you need to 
work with is the window titled Template Categories. 

2- In the Template Categories window, in the list of categories, click the 
General category. All the templates in the General category appear in 
the central window.  

3- �Double-click the template titled Basic Diagram.  
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Basic ���K 

Category ��%4���

Comments G���Q�� 

Create B%'�4 

Diagram ����<� 

Drawing Window ��4������] 

Feature �6�7���

Fill ,����K 

Measurement /(��������	 

Sample ���<� 

Search �H%:) 

Shape ^
� 

Template �.�� 

Title Bar ,���3����� 

Unit �"�7 
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• @������A��Microsoft Visio 2007@���0����;4��@��������4����A�����E:1��7������1��Standard ��7

Professional������;4��/���X� 

• Visio Standard�������E:��B��	������	�������1����%���1��;14���1��#��1�����;���I��G��H��������
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�*�Open Sample Data� �?*Open Diagram� 
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�*�<������ �?*�Alt + F4�� �@*�File�Close� ���*�File�Exit��

<* ��B���&'���P�������Q��Help�=��7��(�'�& ��

�>
�* About Microsoft Visio���Help�� �?*�Contact Us���Help�������     

@*�Check for Updates���Help���� ���*�F1��

8- To create a basic diagram, you should select …………….  in the template 

categories. 

a- Business               b- Flowchart     
c- General            d- Network 

R*���'��7�& �K�ID	 ��.
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���()��

Lasso Select��0� ���
�S	����������P���-��
�. ��[��V��
��"��
����P&������"��
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Multiple Select���	�!
�S	������*��$���%�������0����
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�����������$����f���4�. �����L%4����������)���
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�� �0��	���*�Basic Shapes�. ��Fancy Arrow�������X�K��	��
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Connection points 

A connection point is a special point on a shape that you can “glue” 
connectors and other shapes to. It looks like a blue x ( ). When you glue a 
connector or shape to a connection point, they stay connected, even if one of 
the shapes is moved. Use connection points when you want connectors or 
shapes to stay connected to specific points on a shape. If the shape you want 
to glue a connector or shape doesn’t have a connection point where you want 
it, you can add one. 
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Attach devices  

To attach devices to the Ring Network or Ethernet shape by using the 
shape's built-in connectors:  

1- Click the Ring Network or Ethernet shape.  

2- Place the pointer over a control handle  . When the pointer changes 
to a four-headed arrow, drag it to a connection point  on one of the 
device shapes.  

When the device shape is correctly connected to the Ring Network or 
Ethernet shape, the connection point turns red, indicating that it is glued.  
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�

�������������

	�)���*�	�+,�	-	��.	/��0-1%$�2	-	��$	3�,0�(			!��,4(�	�����	-	5�"�$	/��0-																									 	

&������	��.���'	����.��
	!����	��#$��������������������������������������������������������&������	��.���'%�$�6��	��.	%
���� �

/���0'	7898:787:1;�����������������������������������������������������������������������������/���0'	��0<	%=>�?,������������������������������������ �

� �

 

����������<�0��	�qo9�;) A�8��#��

�� ���;�^����]��)��;) A���;�U�	������ &#���;) A�8��#��"c��"���)�"������	"�:�����&��
����)� � ��:6�

Delete#����J,�	��� �$ 

	� ���)�R���������Delete Object1-����&No����@�2��	�	���� �$ 


� ������E	���A��E�����;�U�	�5*E���� �������3	�� &#��������������;) �A����3��&#����	�� �E�qo9�
"c��"�

:��A��C� ��"����	� �"�;) A�)��<�0��	�����J��"�	�L�5*EM]NOP$ 

 
120�(>�)3�;��<��&�/�?D&�;�A+��1L0�MN� 

�� 1-���&Undo�&��3	�	����Edit&��@�2��	���qo9�5������ ��W+��E$ 

�� ����������)�����;�U�	�5*E������ &#����8���;) A�)�"����	"���)�"c��"�:�������)������
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Set a primary key  

Relationships use primary and foreign keys to map rows in one table to 
corresponding rows in another table. At least one of the tables in the 
relationship must have a primary key in order to establish a relationship. 

1- Double-click the table in your diagram.  

2- In the Database Properties window, under Categories, click 
Columns.  

3- Select the PK box for the column for which you want to use a 
primary key�� 
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Corresponding %����F��G���

Create 8�C�� 

Database ��	����������

Definition a��Z���

Diagram =	�-��� 

Entity "���A����

Exactly ��K�(��̀� �����

Miscellaneous %�-���- 

Null �!���

Object sE��

Relationship <�0��	 

Reverse c�*Z� 

Software =����	1,	 
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 �����$ 

• ��� �Q������	� ��� ��� ��5*E�3	�
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7- Select the ................................. for the column for which you want to use a 

primary key. 

 a- Req'd b- Primary Key c- PK Box d- Data Type 

8- To establish a relationship between two tables ....................... must have a 
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 a- both of them  b- none of them c- no one d- at least one of them 
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Use Case Diagram 

A use case diagram is a diagram that shows the external actors who will 
interact with your system and how they will use it. The diagram consists of a 
system boundary, actors, use cases, and use case relationships. 
(communicates, uses, and extends) In a use case diagram, the communicates 

relationship  defines how an actor participates in a use case.   
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